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Foreword

Information Communication Technology (ICT) is one of the rapidly changing
area in domain of learning. The main purpose of introducing ICT in schools is to help
the students to make use of different ICT tools in enhancing their learning. The ICT
education helps the students to face the challenges of 21st century and attain the
millennium developmental goals in education. ICT also helps in reducing  the digital
divide among the rural and urban students.

As per the UNESCO “technology can be a powerful education multiplier, but
we must know how to use it. It is not enough to install technology into classrooms- it
must be integrated into learning. Nothing can be substitute for a good teacher. It is not
technology itself that empowers people- empowerment comes from skills and
knowledge”.

The teachers have become more critical than ever- the challenge is how to
enable teachers not only to overcome the technology barriers but also to empower
them to integrate appropriate technology into the teaching and learning process.

This handbook contains the required content in using the different tools and use
them in other subjects i.e. Mathematics, Science, Social Science and languages.

 The SCERT, Telangana, Hyderabad appreciates the efforts of the content experts
and other team members in developing this  ICT handbook. We also acknowledge the
C-DAC, Hyderabad for sharing their content related to software security in the
preparation of this handbook.

We hope, the teacher may find this handbook useful and transact it in the classroom
to enhance the learning levels of the students and also infuse confidence among them
as they were not left behind  in using technology on par with other students who are
studying in corporate schools.

 Director
S C E R T,

Telangana, Hyderabad.
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Instructions to Teachers

The main purpose of introducing ICT in school syllabus is to help the children  understand

how to make use of ICT tools in enhancing their learning.

 This material is meant for teacher only. Hence, the teacher should read, understand

and add their experience while transacting the same to students.

 Prepare a year plan in advance keeping in view of the number of periods available

under computer education.

 Read all the topics given in the handbook and prepare thoroughly before start teaching.

 Refer to relevant material and consult the experts in case of any doubts.

 Before going to practice, the theory/ content should be explained to students then

only demo and practice sessions should be taken up.

 All abbreviations must be thoroughly practised  by the teacher before teaching.

 Update your knowledge in software and hardware in addition to the latest ICT tools.

Use internet to update the knowledge in the given topics.

 Ensure all children get equal opportunities in practices.

 There will be two periods in a week for ICT (Computer Education) subject,

accordingly, teacher has to plan for transaction.

 Few projects are given at the end of the handbook. All students should do these

projects. In addition to these, you may consult your colleagues and identify some

more projects and assign to your students.

Assessment :

Children’s performance should be assessed at the end of each summative based on

the indicators given below:

 Students are able to operate and use the ICT tools;

 Students are able to learn subject-wise content by using ICT tools.
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There is no written test. The children performance should be assessed  through

observation based on their participation and their ability in using the ICT tools in their

learning.

Assessment Indicators
In addition to grading the qualitative Indicators are to be written in the students’

progress report under Computer Education. The following are the indicators:

A1 Students can use all the tools of the ICT and can use them effectively in their learning.

A2 Students can use all the tools of the ICT and able to use them in their learning.

B1 Students are able to use different tools of ICT and able to use most of them in their
learning.

B2 Students are able to use the different tools of ICT and use some of them in their learning.

C1 Students are able to use the ICT tools and able to use a few of them in their learning.

C2 Students are able to use some of the ICT tools and try to use them in their learning.

D1 Students are able to identify the ICT tools and try to use a few of them in their learning.

D2 Students are able to identify some of the ICT tools but they are unable to use them in
their learning.

Note: The computer education is linked with Work Education and made a single

paper under other curricular subject areas. Hence, out of 50 marks, each 25 marks are to be

allotted to Work Education and Computer Education.

*****
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Information and Communication Technology (ICT)

Introduction

The field of Information and Communication Technology (ICT) is evolving at
such a pace, where concepts, technology and terminology are continuously changing.
ICT helps to  bridge the digital divide amongst students of various socio economic and
other geographical barriers. Information and Communication Technology (ICT) is
universally acknowledged as an important catalyst for social transformation and national
progress.

Information and communication technology which is a by-product of science
and technology explosion has revolutionized the world of learning. It is very essential
to integrate IT with education in order to have the advantage of ICT education.

Around the world, policymakers and educators have high hopes for ICT in the
classroom as a springboard to students “21st century  skills”—that  combines  the
competencies of problem solving, critical thinking and managing their own learning
that is needed for success in the global workplace. 

Information and Communication Technology (ICT) has dominated every walks
of life affecting right from bus &  railway reservations, hotel industry, online money
transfers , bill payments, in class room  teaching and learning process, distance
education, e-learning and  film making  etc..

The learning activities through ICT make a difference. Students are much more likely
to learn to solve real-world problems and collaborate productively with their peers, if
their learning activities are carefully designed to offer opportunities.

The aim of 21st Century education is being redefined. It is not only for
employment generation but also to create a better world through understanding and
development of human qualities.

In this context, the Government of India has announced 2010 – 2020 as the
decade of Innovation. For which, reasoning and critical thinking skills are essential.
And these skills are to be inculcated at the school level for which ICT tools and
techniques should be integrated into class room instructions right from the primary
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education level, so that the children develop the required skills.  In this matter the web
is an open source and the child should know how to grab it.

According to UNESCO, education is important to achieve the Millennium
Development goals; the following are reasons for which the ICT in education is a key
aspect. i.e., ‘More people would grow and develop; More people would learn and
know; More people would be equal and just; More children would survive and live;
More mothers would be healthier; More people would be able to combat illness;
More people would think of the future; More people would work together.”

The purpose of this material is to create an awareness and practice among the
student and teacher communities with a “diverse set of technological tools, resources
used to communicate, create, disseminate, store, and manage information.” These
technologies include computers, internet, broadcasting technologies (radio and
television) and telephony.

The relevant and contemporary content, lucid language, attractive illustrations
and constructive exercises make the learning of computers more meaningful and
enriching.

The journey of the student starts right from the ICT tools available in and around
such as Radio, Tape recorder, TV, Mobile and Computer. The students of primary level
learn to draw by using MS & Tux Paint, learn to type small words, sentences, paragraphs,
making documents by using typing tutor and MS Word. Moving away a little from these
applications, the students can learn MS Excel for mathematical calculations & graphs
and MS Power Point for making subject wise presentations. Further, the students learn
the concepts of Data Base Management System (DBMS), Internet, Networking and
computer languages, maintaining the computers and its peripherals. The students are
also introduced to learn about the Antivirus, Computer security and privacy and open
source software technologies.

This material is useful in acquiring the concepts  in a better way which make the
student journey in learning more fruitful and engrossing. It has been developed in tune
with the guidelines given by NCF-2005 and with various activity based methods. This
will lay down a path to create interest to take up high level computer education courses
in future and career.
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The government had initiated Computer Education and Computer Aided Learning
in selected Primary, Upper Primary and High Schools. A huge number of teachers in
the State already have been trained to use computers in their regular class room
transactions and a lot of computer aided learning material also has been developed and
supplied to schools.

As part of Education Technology Policy, the Education Department of Andhra
Pradesh has been developing  a large quantity of material in the form of  Audio
(Radio Programs under Vindam Nerchukundam), Audio and Video based programs (SIET
and SAP Net) and Computer based programs(CDs) in collaboration with NGOs.

The Objectives of the ICT in School Education:

 To inculcate the ICT skills among the students of government schools.

 To bridge the digital divide between rural and urban students.

 To create computer awareness and literacy among students and teachers.

 To provide ICT  environment in schools to make teaching-learning process
effective and interesting

 To train the teachers on computer syllabi, emerging information and
communication technologies.

 To develop confidence in students to use computers in future.

 Student-centered pedagogies that promote personalized and  powerful learning
for students;

  Extending learning beyond the classroom in ways most relevant to  knowledge-
building and problem-solving in today’s world; and

 ICT integration into pedagogy in ways that support learning goals.  It is important
to note that ICT use is not a goal in itself, but a tool to broaden and deepen
learning opportunities.
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Teaching Learning Process

The ICT material has been developed from class 1 to class 10. The teacher can
act as a facilitator to help the students in their learning process. In every Unit the
teacher explains the concepts and students do the activities/projects with ICT tools and
finally able to integrate with their subjects.

Academic Standards and Assessment

Academic Standards

 The students are shall operate and use the ICT tools;

 Students are shall learn subject wise contents through the ICT tools.

Assessment Process

At the end of the each chapter exercises and projects have been given. On the
basis of the students performance appropriate grade may be awarded in summative
assessment.

*****
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Learning Objectives

In this chapter you will be able to understand ;

   About ICT Sector.

   Benefits and Limitations of ICT.

About the ICT Sector Unit

Information and communication technologies (ICT) are no longer a luxury for
developing countries and they are already creating new ways of communicating, doing
business, and delivering services. Through extending access and use of ICTs, the World
Bank aims to stimulate sustainable economic growth, improve service delivery, and promote
good governance and social accountability.

Context

Technological progress is a considerable driving force behind economic growth.
ICT infrastructure in particular has attracted much investment, and generated significant
fiscal revenues and employment opportunities in developing countries. The number of mobile
phone subscriptions in developing countries has increased from 200 million in 2000 to 3.7
billion in 2010, and the number of Internet users has grown more than tenfold.

With Internet penetration at a turning point including in the least connected region,
Africa, and with 70 percent of the population in developing countries having access to fixed
or mobile telephone services, ICT networks now constitute a far-reaching service delivery
and citizen participation platform. ICTs can be used as a vehicle to increase accountability,
and can transform and extend the reach of service delivery to the underserved in an innovative,
fast, and cost-efficient manner.

Key challenges and opportunities for developing countries include:

 improving affordability in order to reach the one-third of the population of the poorest
countries who currently live beyond the ICT networks;

 widening access to more advanced ICT services such as broadband for high-speed
internet;

Chapter - 1 What is ICT
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 leveraging the new ICT infrastructure to improve the delivery of services and to build
on it as a source of economic growth; and

 developing and aligning people skills relevant to the Information Technology-enabled
Services (ITeS) industries and knowledge economy.

World Bank Role

Since its inception, the World Bank has supported more than 100 developing
countries with investments and technical assistance in ICT. Since 2003, it has committed
over US$1.3 billion for investment in standalone ICT projects, including US$776 million
from the International Development Association. The Bank’s investments have helped to
attract over US$30 billion in private sector investments in ICT in low-income countries
from 1997-2007.

In addition, the World Bank supports IT components in lending projects across other
sectors, such as education, health, and public sector management. In a 2006 study, this
figure was estimated to be US$7.3 billion in some 1,700 active projects under preparation
or implementation.

The World Bank has disbursed US$45 million on analytical work and technical
assistance in the ICT sector since 2000.

Strategy

World Bank support is evolving to reflect the new challenges and opportunities of
the sector. The Bank Group’s new ICT Sector Strategy will focus on three pillars:

CONNECT: Information and communication infrastructure focusing on broadband
development

INNOVATE: Information Technology (IT)-enabled industry and ICT skills
development

TRANSFORM: Use of ICT applications in specific sectors and contexts (e.g.
agriculture, education, health, good governance, and social accountability)

Technical assistance and investment operations are increasingly focusing on :

 CONNECT: Financing broadband infrastructure: The World Bank recently stepped
up its financing of innovative public-private partnerships (PPPs) as catalytic vehicles
to attract additional private sector investment in broadband infrastructure. This includes
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regional communications infrastructure programs to accelerate the rollout of terrestrial
backbone networks and submarine cable systems in Africa, Pacific Islands and the Caribbean.

 INNOVATE: Supporting the growth of the ITeS industry: Such support helps develop
and align people skills relevant to the ITeS industries and knowledge economy. It
includes a small but growing portfolio of IT industry development projects in Armenia,
Bhutan, Ghana, Kenya, Mexico, and Nigeria.

 TRANSFORM: Using ICT to improve the delivery of public services: The World
Bank is supporting US$7.3 billion of ICT components in projects across other sectors,
such as education, health and public sector management, as determined by a study in 2006.
Components include integrated financial management information systems, computers in
schools and universities, digitization of high court proceedings, and electronic land titling.
This assessment covered 1,700 projects under implementation or preparation across the
Bank portfolio and through stand alone projects such as the eGhana (US$84.7 million),
eRwanda (US$10 million), and eBenin (US$15 million) projects.

Results

Afghanistan : Increasing Access and Affordability through Telecommunications
Sector Reform

In Afghanistan, a US$22 million International Development Association (IDA) credit
supported sector reform that made the telecommunications market more competitive. It
has attracted over US$1.2 billion in private investments, improving access to ICT services
and reducing prices. This helped increase the number of telephone subscribers from 57,000
to 13.4 million between 2002 and 2010, and reduce costs from US$2 a minute to 10 US
cents a minute. The Afghan telecommunications sector now contributes an estimated US$75
million in taxes annually. (Project details).

East Africa : IDA and IFC Support to Communications Infrastructure in East Africa

The IDA-supported Regional Communications Infrastructure Program (FY07-FY13)
and IFC co-financed Eastern Africa Submarine Cable System (EASSy) illustrate a joint
World Bank Group approach to regional infrastructure development.

The first is a US$424 million program that supports the development of
telecommunications terrestrial networks through financing of public-private partnerships
and broadband capacity purchases.
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The second is a US$240 million submarine cable connecting the east coast of Africa
(from South Africa to Sudan) to Asia and Europe. These projects have contributed to a 90
percent reduction in wholesale capacity prices in East Africa, with retail prices already
starting to drop by about one-third in Kenya and Rwanda. In Kenya, this has helped in
increasing the number of internet users to 8 million in 2010 from 2 million in 2007. (Project
details)

Ghana : Innovative Project Design through e-Government PPPs in  e-Ghana

The e-Ghana Project (FY07-FY12, IDA) has an innovative design featuring a public-
private partnership (PPP) to transform revenue collection, using a joint venture between
Government revenue agencies and a private sector partner. The project has helped the
Government attract US$40 million in private sector investment for developing and deploying
an electronic tax application to automate revenue agencies and the Registrar General’s
Department. Upon completion, this application is expected to help the Government increase
compliance and transparency, and broaden the tax base, while reducing the incidence of
fraud, upgrading Government employee skills, and developing a template for upgrading
other agencies.

The eGhana project is providing support to the local IT-enabled services (ITeS)
industry including support to develop a Business Process Outsourcing Facility. Over 1,000
jobs have been created in the industry during the last two years. The eGhana Project is also
providing financial assistance to support a partnership between the public and private sector
to train some 50 training institutions and 6,000 business process outsourcing agents. This
is expected to further strengthen Ghana’s position as one of the most attractive locations
for ITeS business in Africa. (Project details).

Mexico : Skills Development for Improved Employability in the ITeS Industry

Through the Mexico IT Industry Development Project (FY09-FY13, US$80 million,
IBRD), the World Bank has assisted the Government of Mexico in the creation of
MexicoFIRST, an institution aimed at closing the gap between demand and supply of skilled
workers in the ever-changing IT industry. Through partnerships with global companies and
strong links to local IT clusters, academia, and industry associations, MexicoFIRST provides
certification programs that increase the quality of the Mexican labor pool. Students pay
between 10 and 40 percent of the certification prices, making it more affordable.
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As of 2010, more than 6,000 people have been trained and certified in skills that
will qualify them for employment with higher salaries. It is expected that more than 30,000
people will be certified by the end of the project. (Project details)

Nicaragua : Extending Telecommunications Service to Unserved Rural Areas

In Nicaragua, a US$16 million project supported the strengthening of the regulator,
privatization of the incumbent telephone operator in 2001, and introduction of competition
in the sector in 2005. It helped to bring about a ten-fold increase in mobile subscriptions by
2010. Total telephone penetration (fixed plus mobile) increased from 6 percent in 2001 to
25 percent in 2005, and to over 60 percent in 2008.

Thanks to a US$10 million follow-up project, to which IDA contributed US$7 million,
more than 350,000 people in 350 communities in rural Nicaragua received access to
telephone services and more than 860,000 people in 104 rural municipal towns received
Internet connection for the first time. One hundred public Internet access centers were
installed by the project for the benefit of those who could not afford to have direct access
in their homes. They pay a modest hourly fee for using Internet access and receive free
training for using the service, as well as for basic computer tasks. (Project details)

Rwanda :  Bringing Public Services to the Fingertips of Citizens

In Rwanda, the eRwanda project (US$10 million IDA grant) supports the
government’s efforts to use ICT for improving service delivery. The project has funded
networks in government ministries and district offices around the country, and the
development of a government portal linking government information and websites. The
project also financed 18 telecenters for rural populations and equipped 12 district offices
with computers and office software, allowing the local government offices to be connected
to Kigali’s central government. Additionally, four ICT buses funded by the project have
been roaming among Rwanda’s district offices, teaching ICT skills to youths, civil servants,
farmers, politicians and private sector entrepreneurs.

Throughout the project, 2,822 citizens were trained on ICT subjects, helping them
gain skills that will serve them throughout their lifetimes as employees, entrepreneurs, and
local leaders, including 760 district office staff. eRwanda also had a strong gender focus
and among the trainees were 685 council women in rural areas.

*****
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Learning Objectives

In this chapter you will be able to understand about ;

   Learn about the Tablet PC.

A tablet computer, or simply tablet, is a
one-piece mobile computer. Devices typically
offer a touchscreen, with finger (or stylus)
gestures acting as the primary means of control,
though often supplemented by the use of one or
more physical context sensitive buttons or the
input from one or more accelerometers; an on-
screen, hideable virtual keyboard is generally
offered as the principal means of data input. Available in a variety of sizes, tablets customarily
offer a screen diagonal greater than 7 inches (18 cm), differentiating themselves through
size from functionally similar smart phones or personal digital assistants.

Though generally self-contained, a tablet computer may be connected to a physical
keyboard (or other input device), and a number of
Hybrids that offer a detachable keyboard have been
marketed since the mid-1990s, as have a number of
convertible touch screen notebook computers that
offer an integrated keyboard that can be hidden by a
swivel joint or slide joint, exposing only the screen
for touch operation. Tablets have also appeared in a
foldable Booklet format that offer the user dual-touch
screens, and can be used as a notebook by displaying
a virtual keyboard on one of the displays.

Touch user interface

A key and common component among tablet computers is touch input. This allows
the user to navigate easily and intuitively and type with a virtual keyboard on the screen. The

Chapter - 2 Types of Computers - Tablet PC
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first tablet to do this was the Grid Pad by GRiD Systems Corporation; the tablet featured
both a stylus, a pen-like tool to aid with precision in a touch screen device as well as an on-
screen keyboard.[35]

The event processing of the operating system must respond to touches rather than
clicks of a keyboard or mouse, which allows integrated hand-eye operation, a natural part
of the somatosensory system. Although the device implementation differs from more
traditional PCs or laptops, tablets are disrupting the current vendor sales by weakening
traditional laptop PC sales in favor of the current tablet computers

Handwriting recognition[edit]

Chinese characters like this one meaning “person” can be written by handwriting
recognition ( , Mandarin: rén, Korean: in, Japanese: jin, nin; hito, Cantonese: jan4). The
character has two strokes, the first shown here in dark, and the second in red. The black area
represents the starting position of the writing instrument.

Some tablet personal computers such as the Galaxy Note 10 utilise a stylus. These
tablets often implement handwriting recognition. Tablet computers with finger driven screens
usually do not. Finger driven screens are potentially better suited for inputting “variable-
width stroke-based” characters, like Chinese/Japanese/Korean writing, due to their built in
capability of “pressure sensing”. However at the moment not much of this potential is already
used, except in digital art applications like Autodesk Sketchbook for the iPad, and as a
result even on tablet computers Chinese users often use a (virtual) keyboard for input.

Touch screen hardware

Touch screens are usually one of two forms;

 Resistive touch screens are passive and can respond to any kind of pressure on the
screen. They allow a high level of precision, useful in emulating a pointer as is common
in tablet computers) but may require calibration to be accurate. Because of the high
resolution of detection, a stylus or fingernail is often used for resistive screens. Limited
possibilities exist for implementing multi-touch on a resistive touch-screen. As modern
tablet computers tend to make heavy use of multi-touch, this technology has faded out
on high-end devices where it has been replaced by capacitive touchscreens.

 Capacitive touchscreens tend to be less accurate, but more responsive than resistive
screens. Because they require a conductive material, such as a finger tip, for input,
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they are not common among (stylus using) Tablet PCs but are more prominent on the
smaller scale “tablet computer” devices for ease of use, which generally do not use a
stylus, and need multi-touch capabilities.

 Palm recognition, It prevents inadvertent palms or other contacts from disrupting
the pen’s input.

 Multi-touch capabilities, which can recognize multiple simultaneous finger touches,
allowing for enhanced manipulation of on-screen objects.

Some professional-grade Tablet PCs use pressure sensitive films that additionally
allow pressure sensitivity such as those on graphic tablets.

Concurrently capacitive touch-screens, which use finger tip detection can often detect
the size of the touched area, and can make some conclusions to the pressure force used, for
a similar result.

*****
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Learning Objectives

In this chapter you will be able to understand about ;

   Artificial Intelligence – AI.

As a part of IPO cycle the AI (Artificial Intelligence) let us understand about the AI
in this chapter.

Artificial Intelligence

Artificial intelligence (AI) is the science of making machines do things that would
require intelligence if done by humans.

For example, make a machine play chess or find a patient’s illness or teach
geography. Artificial intelligence programs are often involved with processes such as:

 Remembering and accessing relevant knowledge.

 Revising and extending their knowledge.

 Searching in a more systematic way for a solution to a problem. Recognising
similarities between things.

 And trying to understand some aspect of their surroundings, for example, something
communicated to them in English.

The concepts from disciplines such as psychology, linguistics and computer
science are used by researches to prepare programs or create systems to do tasks
automatically.

Computers were programmed years ago to play checkers against human opponents.
In one case the program improved the game to the point where it easily defeated its author
or the builder. Thus the machine learned what not to do by trial and error. Hundreds of
chess playing programs have also been written that can run on machines ranging from
micros to supercomputers. The possible number of moves in a chess program is so large
that all could not be stored or analysed by any computer.

Chapter - 3 Working of PC – IPO Cycle
(Artificial Intelligence)
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Researchers then started building neural-network computers, which are machines
with circuits patterned after the complex interconnections existing among the neurons, or
nerve cells. Neural network computers now have processing elements, or simulated
neurons, that number in hundreds or thousands, and there are thousands or millions of
interconnections between these elements. In contrast, humans have about 10 billion
neurons in the thinking part of their brains, and there are at least 100 trillion
interconnections between nerve cells.

Expert Systems

An example of AI is the use of expert systems. An expert system is a software
package that attempts to encode the knowledge and decision rules of human specialists. A
complete expert system package includes two components:

   Knowledge base

    Expert System Shell

Knowledge base - there is a stored knowledge base that may be filled with “if-
then” facts (such as if the sun shines over the sea then the water will evaporate), and general
rules (such as: if the student walks 20 minutes late to the class then punish him).

Expert system shell - there is an expert system shell of linguistic and reasoning
mechanism. This can probe the knowledge base to reach conclusions and recommend
solutions to specific problems.

The need of an expert system in an organisation

 To preserve knowledge that might be lost if a company expert retires, resigns, or dies.

 To clone specialist expertise so that beginners at different locations can be trained to
perform as the expert does.

 To develop the knowledge-base component for an expert system.

Researchers and knowledge engineers of artificial intelligence spend more time in
knowing the brain of specialists. The aim was to extract and structure the knowledge that is
the basis for the specialists’ expertise. When the user supplies the data, the expert system
should respond like an intelligent assistant by suggesting possible decisions.
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Uses of the Expert systems

A geology package

An expert system called prospector asks the user about an area’s geological
formations and then gives advice on the possible location of mineral deposits. Prospector
has predicted accurately the location of a multimillion-dollar molybdenum deposit under
mount Tolman in East Washington.

Medical diagnostic package

Expert programs have been developed to diagnose diseases and advise treatments.
One such system called HELP, is used to diagnose the problems of patients with heart
disease. HELP collects patient data from health care professionals, and suggests probable
diagnosis and treatments.

Another diagnostic expert systems called Puff, is used to measure lung functions.
Caduceus, a more generalised package is programmed to evaluate over 4,000 symptoms
and other data in order to recognise over 600 diseases. Caduceus accepts the initial input
data about a patient from the doctor. The program provides the diagnosis for the doctor in
a few minutes.

AI and the Future

The Japanese expect to achieve leadership in AI technology with a supercomputer
capable of storing a knowledge base of up to 20,000 rules and 100 million data items. The
U.S government’s Defence Advanced Research Projects Agency (DARPA) is also spending
hundreds of millions of dollars on a Strategic Computing Initiative (SCI) program to
achieve dramatic advances in microelectronics, computer architecture, and AI. The
achievements of the combination of the superiority of the human brain and the speed and
accuracy of the computer will be limitless. The alliance between human and computer can
produce a synergistic effect. The word synergy refers to the ability of the two entities to
achieve together what each is incapable of achieving alone.

*****
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Learning objectives

In this chapter you will be able to understand about ;

   Input devices:  Scanner.

Scanner

Scanners are one of the more prevalent computer peripherals. They are used to scan
printed documents, such as old photographs, pages from books and magazines, and hand-
drawn artwork. Flatbed scanners are the most common type, and there are many features
offered by different models of flatbed scanners

What is a Flatbed Scanner?

A scanner is a device that creates a digital representation of a tangible object. A
flatbed scanner is named for its platen (or glass plate) that literally creates a “flat bed” on
which the object being scanned rests. Its counterpart is the drum scanner, which, as its name
implies, uses a drum for scanning. One of the benefits of the flatbed scanner is that scanned
objects remain stationary, so it’s suitable for delicate originals or even 3-D objects.

Important Components

The most important component of the flatbed scanner is the charge coupled device
(CCD). Scanners work by shining light on the object and using mirrors to reflect it to a
photosensitive device. Flatbed scanners use CCDs for that process, and the CCD collects
the reflected light and converts it to a series of electronic signals. The CCD is a “coupled”
device as it uses two types of arrays: one to image the scanned object and the other to store
it as pixels.

Sizes

 Flatbed scanners are available in a range of sizes. Most scanners designed for household
and small office use can scan a maximum size of 8.5 by 11 inches (or standard letter
or A4 size originals). Larger scanners accommodate tabloid-size sheets and can scan
sizes 11 by 17 inches to 12 by 18 inches. Those are typically found in graphic art
studios and pre-press departments.

Chapter - 4 Input Devices
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Resolutions

 Resolution determines the quality of the digital image. It refers to how many dots
make up the image and is expressed as dpi (dots per inch) or ppi (pixels per inch). The
numbers that express resolution are given to indicate the dot count along both the X
and Y coordinates. For example, a scanner that provides 4800 dots per horizontal inch
(the X coordinate) and 9600 dots per vertical inch (the Y coordinate) is said to have a
4800 by 9600 resolution. Many manufacturers abbreviate that specification and only
refer to the X coordinate for resolution.

How Much Resolution is Enough?

 When it comes to resolution, more is not always better. Flatbed scanners with high
resolution capabilities are more expensive, so it’s important to determine how much
resolution you require. The highest quality scans will yield the highest quality printed
output, especially in large formats, and they will also create very large files.
Resolutions at 4800 are required for high quality output, but the printer or press that
is to be used to reproduce the image is also a determining factor in the final quality.
Not all output devices can print high resolutions, so high resolution scanning might be
wasted. If you use your scanner primarily to scan images for on-screen viewing, you
also do not need a high-end scanner.

 Resolutions at 2400 are good all-purpose devices and suffice for home computing
needs. Flatbed scanners for documents only (text without graphics or images) have a
600 dpi resolution, which is adequate for that type of scanning.

Bit-Depth Color

 Another defining specification for flatbed scanners is the color bit depth. Broader
color rendering and representation can be gained with higher bit depths. The most
basic scanners have a 24-bit color depth, while higher-end models provide 48-bit color.
Using a 24-bit color scanner will be fine for scanning colored charts and graphs. If
you will be scanning a lot of photographs, it’s best to use a 48-bit color device, as it
will be able to capture the tonal shades associated with photos. Scanners with 96-bit
color can discern the widest array of colors and are used by professionals for scanning
paintings and other original artwork.
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Summary

 In this chapter we have learnt about the Flatbed Scanners.

 Demonstrates the functioning of Scanner.

 Scan a text book picture in various resolutions and compare.

 Resolution

 Flatbed

 CCD - Charge Coupled device

 PPI - Pixels Per inch

 DPI - Dots per Inch

*****
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Learning Objectives

In this chapter you will be able to understand about ;

    Memory and storage

    Memory – RAM and ROM

    Storage Capacity

    Computer Storage

Refers to the data stored in an electromagnetic form to be used by the processor

Storage Capacity

Storage capacity is the number of characters that can be stored on a computer.

You can measure the amount of data stored on a computer just as you can measure
the amount of water in a container, although measurement units are different.

 Computer stores a variety of data and information in its memory

 Stores numbers (0-9), letters (A-Z) and symbols and other characters (#, {}, ‘, ~, ̂ )

 Uses the binary system to represent these characters

 The 0s and 1s in the binary system are known as bits (binary digits)

 A bit is the smallest unit of measurement of storage capacity

 A set of eight bits is called a byte

 Kilobytes, megabytes, gigabytes and terabytes are higher units for measuring the storage
capacity of a computer

Explain this table of measurements

8 bits = 1 byte
1024 bytes = 1 kilobyte (KB)
1024 KB = 1 megabyte (MB)
1024 MB = 1 gigabyte (GB)
1024 GB = 1 terabyte (TB)

Chapter - 5 Computer  Storage
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Computers use two types of storage:

1. Internal storage

2. External storage

Internal Storage :

 It is one of the main components of the system unit

 Also known as the main memory

 Stores data and instructions on the computer

 Stores the output data temporarily before it is sent to the output device

 It is volatile and its capacity is also limited;

 This means that the contents in the memory will be lost when the computer is turned
off

 The act of retrieving existing data from memory is called reading

 The process of storing data in memory is called writing

There are two types of internal storage:

Random Access Memory (RAM)

Read Only Memory (ROM)

The storage capacity of RAM will vary from one computer to another. The capacity
of RAM ranges from 4 MB to 8 GB or more.

Differences between RAM and ROM

Random Access Memory (RAM) Read Only Memory (ROM)

Temporary storage area for Permanent storage area for holding
holding programs and data instructions to start a computer

Data is lost as soon as power Instructions are not lost as soon as
is switched off power is switched off
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External Storage

 It is a permanent storage area

 Stores data and programs that are not needed immediately by the computer

 Also known as secondary storage

 Data stored in this medium is permanent

 It is inexpensive and has a large storage capacity

You need a storage device called a drive to write to and read from a storage medium

A computer’s internal storage or main memory is volatile. This means that the
contents in the memory will be lost when the computer is turned off. The storage capacity
of the primary memory is also limited.

Some of the commonly used external storage devices are:

 Hard disk drives

 Floppy disk drives

 Compact Disk – Read Only Memory (CD-ROM) drives

 Digital Video Disk (DVD) drives

 CD and DVD writers

Hard Disk Drive

 Is an external storage device used to store large quantities
of data?

 Is attached to the system unit from within?

 Is packaged along with the hard disk ?

 Is used to read data from and write data to the hard disk?

 Has a storage capacity varying from 40 GB to 500 GB to a few terabytes?

Floppy Disk Drive

 Is an external storage device used to read from
and write to a floppy disk.

 Floppy Disk:

 Is also called a floppy or diskette.
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 Is a portable storage medium that can store a small amount of data.

 Has a storage capacity of 1.44 MB.

 Is prone to damage by heat and dust.

Compact Disk -Read Only Memory (CD-ROM) Drive

 Is used to read from a CD-ROM.

 Is a storage medium.

 Has a large storage capacity of 650 MB or 700 MB.

 Is less prone to damage.

 Is nowadays available as rewritable CD.

 Handle CDs carefully. If the CD is scratched, you may not be able to read the CD
contents.

 Floppy drives and hard drives can perform both read and write operations. Hence,
they can be called input/output devices. A CD-ROM drive can only read from a CD-
ROM and not write onto it. Hence, it is only an input device.

Rewritable CDs and CD Writers

 Are storage devices that can write data to a CD.

 Store a large amount of data on a CD, with a minimum range starting
at 650 MB.

 Can read CD-ROMs.

Digital Video Disk (DVD) Drive

 Is an external storage device.

 Used to read from a DVD-ROM.

DVD-ROM :

 Is similar to a CD-ROM.

 Can store a  minimum of 4.7 GB and maximum up to 17 GB.

 Used to store multimedia objects that combine high quality sound and graphics.

 A DVD drive is capable of reading from CD-ROMs.
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Comparison between Floppy Disks, Hard Disks,  CD-Roms and DVDS

 Collect and show the various types of storage media.

 Differentiate between CD & DVD.

 Differentiate between Hard disk & Floppy disk.

 Differentaite between movable & stable storage media.

 Differentiate between storage, capacities of floppy, CD & DVD,  selects and storage
media depending an data size.

 Differentiate between read, write storage media.

 Hard Disk     DVD    Read only memory

 Storage capacity     Secondary storage

*****

Floppy disk  Hard disk  CD-ROM  DVD  

Also referred to as 
diskettes or floppies  

Also referred to as the 
fixed disk  

Also referred to as 
compact disc  

Also referred to as 
digital video disc  

Is removable  Non-removable Is removable.  Is removable.  

Less resistant to 
damage as made of 

vinyl material 

Less prone to damage 
as it is inside the system 

unit  

Is more reliable 
than a floppy disc 

Is more reliable than a 
floppy disc 

Can store 1.44MB of 
data 

Can store 40 GB of data 
or more  

Can store 650 MB 
or 700 MB of data  

Can store a minimum 
of 4.7 GB of data  

Can be used to read 
and write data  

Can be used to read and 
write data  

Is read-only  Is read-only  
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Learning Objectives

In this chapter you will be able to ;

    State the need for networks

   Define a network

    List the different types of networks

   List the various components of a network

   Define basic terms related to networks

   List the types of LAN

   Define workgroup and domain

Networking

What is a network?

A network refers to an arrangement of things. For instance, you may have come
across the sentence, ‘The state has a very good network of roads’. This signifies that there
is a good system of roads that reaches out to every corner of the state. In other words, the
cities, towns and villages of the state are well connected through the wide network of roads.
It also signifies that these cities, towns and villages are dependent on the interconnectivity
that this network of road provides.

We can extend this analogy to computers, too. When we say that a group of
computers is  ‘networked’, it implies that these computers are linked by means of a
communication system. Technically speaking, the term ‘computer network’ refers not just
to the computers but includes the software that helps them communicate and the
transmission methods used in such communication. Therefore, it includes the whole range
of hardware and software components that make a computer network operate.

Thus, networking is the process of linking several computers together in order to
enable them to communicate with each other. The interconnection of the hardware and
software components of a group of computers is known as a Network.

Chapter - 6 Computer Network – Security
and Ethics
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Advantages of Networking

 Networking allows sharing of files and documents among various systems in the network.

 Networking allows sharing of hardware and software resources among various systems.

 It also provides an improved communication link between users in a network.

Types of Network :

Networks vary widely in their size, complexity and geographical spread. One way of
classifying networks is based on their geographical spread. On this basis, networks can be
classified into

    Local Area Network (LAN)

    Metropolitan Area Network (MAN)

    Wide Area Network (WAN)

Local Area Network :

A LAN is a group of computers and other devices
distributed over a limited area and connected by cables.
Example: Computers in a school.

Metropolitan Area Network :

A MAN is a communication network that
connects computers and other devices that are
distributed within the geographical boundaries of a
city or town. Example: The railway reservation
system in a city.

Wide Area Network :

A WAN is a communication network that
connects geographically separated areas such as
countries or even continents. Majority of the
WANs use satellites as their primary medium of
transmission. Example: The Internet
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Components of a Network

 Components of a network can be classified into two headings namely logical
components and physical components.

 The Logical components of a network consist of the Network Operating System
(NOS) and the associated protocols.

 The Physical components of a network comprise network adapter cards, cabling
systems that connect the computers, telecommunication lines, satellites and hubs.

Network Operating System

The operating system that enables a computer to participate in a network is known as
the Network Operating System.

Some of the popular network operating systems are listed below.

    Variants of UNIX like IRIX, Linux, HP-UNIX and Solaris

    Novell NetWare from Novell

    Windows NT from Microsoft

Network Protocols

A protocol is a set of rules and conventions to be followed for sending and receiving
information over the network. The set of rules governs the following:

    the content of the information

    the format in which the information will be sent

    the timing and the sequence in which the information will be sent

    the error control messages that are sent

In a network, these rules are implemented through a set of software. Some
commonly used software for implementing these rules and conventions are listed below.

    Ethernet Protocol

    Transmission Control Protocol/Internet Protocol (TCP/IP)
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Terms Related to Networks

Node

A node is a device that is directly attached to the network. Generally, the term is
used in the context of computers attached to a network. However, there are other devices
such as network printers that can be attached directly to a network. If these devices are
attached to a network, they are also referred to as nodes.

Workstation

Workstations refer to the computers that are attached to a LAN and are seeking to
share the resources of the network. A workstation is also known as client. LAN connects
all the individual workstations together and each workstation has access to resources
available through the network. A workstation that is part of a LAN can still be used
independently.

Server

A server is a computer that shares its resources with the other workstations in a
network. Servers are of two types: dedicated server and non-dedicated server.

Dedicated Server

A dedicated server is one that can work only as a server and cannot double up as a
workstation. This type of server is used in very large networks. Here the only job of the
server is to help workstations access data, software and hardware resources.

Non-dedicated Server

A non-dedicated server is simply another workstation. The computer acts as a
server by providing resources to the workstation on the network and also doubles up as a
workstation. This type of server is suitable for smaller networks, which have fewer
workstations.

Types of LAN :

LAN can be classified into two types: peer-to-peer network and client/server
network.
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Peer-to-peer network :

A Peer-to-peer network is a network in which every node can act as both a client
and a server. Each node can share its resources with other nodes on the network. Every
computer on this network takes an equal part in the networking process and is ideally suited
for smaller networks.

Consider a peer-to-peer network of four computers. Assume that ‘node2’ on the
network needs to access a PowerPoint presentation from ‘node3’. When ‘node2’ is
accessing the presentation from ‘node3’, ‘node3’ becomes the server and ‘node2’ becomes
the client. Now assume that ‘node1’ needs to access a file from ‘node2’. Here, ‘node2’ is
the server and node1’ becomes the client. Therefore, any system in a peer-to-peer network
can act both as a client and a server.

Client/Server Network :

A client/server network involves using a powerful computer, which runs a network
operating system and acts as the server in the network. This network operating system
manages the communication link between the server and the client. In this type of network
setup, the administration of security and user account information is centralised. These
networks are easier to administer and control, especially in a large network setup.

Consider a client/server network of 20 computers. In this setup ‘node1’ is
designated as the server and it is the only system that can provide network services to the
clients. The remaining 19 nodes are designated as clients. In this setup, clients can never act
as servers.

Workgroup

A workgroup is a logical grouping of computers on a network. Each workgroup on a
network is identified by a unique name. In this network setup, resources are shared among
the nodes and security information is distributed to each node that acts as a server. Peer-to-
peer network setup is otherwise called a workgroup.

In a workgroup, the maintenance of security becomes cumbersome as the network
grows. This is because there is no centralised administration of security information and
resources.
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Domain

A logical grouping of computers and users that share a common security database is
known as a domain. This grouping of computers and users is done mainly to implement
security for users and resources. A client/server network setup is otherwise called a
domain.

Summary

 The interconnection of the hardware and software components of a group of computers
is known as a Network.

 The three types of networks are LAN, MAN and WAN.

 Components of a network include:

 Logical Components – consist of the Network Operation System (NOS) and the
associated protocols.

 Physical Components – comprise the network adapter card, network cables,
telecommunication lines, satellites and hubs.

 The Network Operating System allows a computer to participate in a network.

 A protocol is a set of rules and conventions to be followed for sending and receiving
information over the network.

 A node is a device that is directly attached to a network.

 Workstations refer to computers that are attached to a LAN and are seeking to share
the resources of the network.

 A server is a computer that shares its resources with the other workstations on a
network. Servers are of two types: dedicated server and non-dedicated server.

 Peer-to-peer network is a network in which every node can act as both a client and a
server.

 A client/server network involves using a powerful computer, which runs a network
operating system and acts as the server in the network.

 A workgroup is a logical grouping of computers, which enables users to browse the
network.
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 A logical group of users and computers implemented for security purposes is known
as a domain.

 Shows the computer lab network.

 Demonstrates its functioning.

 Explains its components.

 Identify the components of lab network.

 Observe and record various networkers used in the open market.

Fill in the blanks

1. The interconnection of the                       and                       components of a group of
computers is known as a network.

2. WANs use                       as their primary medium of transmission.

3. The operating system that enables a machine to participate in the network is known as
the                        operating system.

4. A                       is a computer that shares its resources with the other workstations on
a network.

5. Peer-to-peer network is a network in which every node can act as a                     and a

 LAN   MAN   WAN   NOS

 Server   Node  Work Station    Protocol

.

*****

Teacher Activity

Key Words

Student Activity

Test Your Knowledge



ICT Teacher Hand Book 31

Windows – Organizing Data: Running an application

Learning Objectives

In this chapter you will be able to understand about ;

   Open Windows Explorer

   View files and folders by using Windows Explorer

   Create folders

   Create files

Windows Explorer

Windows Explorer is a tool that is used to browse through the entire system,
including the network drives (refer Figure 1)

Figure 1: Windows Explorer window
To open the Explorer,

1.   Click the Start menu.

2.   Choose the All Programs option.

3.   Choose the Accessories option.

4.   Click the Windows Explorer option (refer Figure 2).

Chapter - 7 Organizing Files and Folders
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Menu bar
Toolbar
Address bar

Folders pane Work area

 

 

 

Figure 3: Parts of the Windows Explorer window

Figure 2: Opening Windows Explorer

Tip : You can also use the Windows   +   key combination to view the Windows
Explorer window.

With the help of Explorer, you can view the contents of the computer and the
hierarchy of the folder structure.

The Windows Explorer window has a menu bar, toolbar, address bar and two panes.
The left pane is called the Folders pane. The right pane is called work area.

 

Click
Windows
Explorer

Choose
Accessories

Choose all
Programs

Click Start
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The Folders pane

The Folders pane displays the hierarchy of folders.

(refer Figure 4)

To view the Folders pane,

1.   Click the Folders button   in the toolbar..

Alternatively,

1.   Click the View menu.

2.   Choose the Explorer Bar option.

3.   Click the Folders option (refer Figure 5).

Creating a Folder in the C Drive Using Windows Explorer

The steps for creating a folder in Windows Explorer are the same as that of the My
Computer.

To create a folder in the C drive using the Windows Explorer,

1.   Select the C drive in the Folders pane.

2.   Right-click the right pane.

3.   Choose the New option  on the shortcut menu.

4.   Click the Folder option.

Alternatively,

1.   Click the File menu.

2.   Choose the New option.

3.   Click the Folder option.

Figure 4: The Folders pane

Figure 5: The Folders option on the View menu
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Creating a File in the C Drive Using Windows Explorer

You can now create files within your folder. Suppose you want to create a text
document to store your friends’ phone numbers.

To create a file within a folder:

1.   Double-click the folder you just created.

When you double-click a folder, its contents are displayed. Since the folder you
created is empty, nothing will be shown.

2.   Click the File menu.

3.   Choose the New option.

A submenu appears.

4.   Click the Text Document option.

A text file is created in your new folder as shown in the Figure 6.

Note : Text file is a simple file in which you can type text. The extension of a text file is
.txt, where txt denotes a text file.

Alternatively, to create a file:

1.   Right-click anywhere on the blank area in the right pane of the Windows  Explorer.

2.   A pop-up menu appears.

3.   Choose the New option.

4.   Click the Text Document option.

A new text document gets created.

Viewing Folders Using the Windows Explorer

To view the folders using the Windows Explorer,

    Double-click the folder.

Alternatively,

1.   Right-click the folder.

2.   Click the Open option on the shortcut menu.

Tip : You can also select the folder and click File ?  Open to open a folder.

Figure 6:  Newly created document
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A + sign before a folder means that the
folder has subfolders under it. Clicking the +
sign will display the subfolders and the sign
will change to –. Clicking the – sign will
display only the parent folder and the – sign
will change to +.

For example, in Figure 7 the folder
Subjects has + sign before it. This denotes that it has subfolders. When the + sign is clicked,

the subfolders English, Maths and
Science are displayed and the sign
changes to - When the + sign before the
folder English is clicked, subfolders
Essay, Grammar and Short Stories are
displayed. Notice that there is no sign
before the folders Essay, Grammar and
Short Stories. This indicates that they
do not contain any subfolders (refer
Figure 8).

In this folder structure, folders Essay, Grammar and Short Stories are the subfolders
of the folder English. English is also a subfolder of the folder Subjects, which is a parent
folder.

Now You Know

 Windows Explorer is a program that enables you to view the contents of the entire
system.

    You can view the contents of the computer, and the hierarchy of the folder structure
using Windows Explorer.

 Demonstrate organising files or folders.

I Hands on practice for organising files & folders.

 

Figure 7: Viewing folders

 

Figure 8: Displaying the folder hierarchy in
Folders pane

Teacher Activity

Student Activity
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II Do the following

1. Create a shortcut for Microsoft PowerPoint on the desktop.

2. Open Windows Explorer.

3.   Create a folder “Student” in the desktop.

4.   Create a folder under C:.

5.   Create a text file under the New Folder.

6.   Select the C: icon.

7.   View the list of folders and files in the right pane. Check if the files and the folders you
created are shown.

8.   Select the Desktop icon. List the icons shown in the right pane.

I True or False

1.   You cannot create your own folders.

2.   Text document is a program that enables you to view the contents of the entire system.

3.   Folders cannot contain folders within them.

4.   A folder is automatically named as “Folder” when it is created.

 Windows Explorer

 Work Area

 Left or Right Pane

 . txt

 + sign

 - sign

*****

Test Your Knowledge

Key Words
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Learning Objectives

In this chapter you will be able to understand about ;

View presentations in different modes like

•  Normal view

•  Slide sorter view

•  Notes Page view

•  Slide show view

Change the background of slides

Apply design templates Change the slide layout Change the colour scheme - Add
slide transitions

Views in PowerPoint

While creating a presentation, sometimes it is helpful to see the entire content to
reorganize it and to see what the audience will see during the presentation.

PowerPoint has several ways of viewing your slides while creating it.

To change the view:

1.   Click the View tab.

2.   Click the required view (refer Figure 1).

Normal View

Normal view is the main editing view,
which you use to write and design your
presentation. The screen is split into three sections. On the left, there are tabs that alternate
between an outline view of your slide text (Outline tab) and your slides displayed as
thumbnails (Slides tab). On the right, there is the slide pane, which displays a large view of
the current slide. At the bottom, there is a pane to enter notes (Refer Figure 2).

Figure 1: Changing the View

Chapter - 8 Enhancing Presentation in
Power Point
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Figure 4: The Notes Page View

Slide Sorter View

A small image of each
slide is displayed in the Slide
Sorter view. Slides can easily
be ordered and sorted from this
screen (Refer Figure 3).

You can use the icons on
the Slide Sorter toolbar to set
timings for a slide show and to
apply animations and
transitions. You can also easily

move and copy slides in this view.

Notes Page View

The Notes Page view is used to
enter notes for slides within a
presentation. Each notes page includes an
image of the associated slide, below which
there is an area where you can enter text.
Notes pages act as a script for the
presentation. It can hold as much text as it
can fit on one page (Refer Figure 4).

 

Figure 2: The Normal View

Outline and
Slides Tab

Thumbnails
of slides

Enter Notes here

Figure 3: The Slide Sorter View
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Slide Show View

The Slide Show view displays slides in full screen mode. When you use this view,
the PowerPoint window is not visible and each slide occupies the complete screen area.
This view helps you see how the slide will actually look like when the presentation is made.

Changing the Background of the Slides

You want to change the background of the slides to
yellow. You can change the appearance of your slide
background by changing its colour, shade, pattern or
texture. You can also use a picture as a slide background,
but you cannot use more than one picture.

To change the colour or the effect of the existing slide
background:

1.   Select the slide for which you want to apply a colour.

2.   Right click the slide.

3.   Select the Format Background option.

4.   A Format Background dialog box is displayed.

5.   Select the colour by clicking the Color list box. (Refer Figure 5)

6.   If the colour is not available in the colour scheme,
     click the More Colors option and select the color
     you want.

7.    To apply the change to the current slide, click the
        Close button. To apply  the change to all the slides,
      click the Apply to All button.

The background of your slides has changed
(Refer Figure 6).

Applying Design Templates

A design template is a slide that has a pre-defined background design, background
colour, font style and font colour. This can be applied to the slides in your presentation. A
variety of design templates are available. You have to choose a template that will best suit

Figure 5: The Notes Page View

Figure 6: Slide after changing the
background
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Figure 8: Applying a design
template

Figure 9: Changing the slide layout

Content with
Caption

your presentation. The design templates can be
applied in the beginning, when you create a new
presentation. You can also change the design of your
slides at any point of time.

To change the design template:

1.   Click on the Design tab. Various design templates
will be displayed in the Themes group. (Refer
Figure: 7)

2.   Move the mouse on each template to see the preview.

3.   Select the design template by clicking it.

4.   The design template will be applied to all the slides.

If you want the design template to be applied to one or
more selected slides, then click the Apply to Selected
Slides option. If you have not selected any slide, it will
apply the layout to all the slides.

5.   Right-click on the Design Slide. From the pop up box displayed select the required
option. (Refer Figure 8)

Changing the Slide Layout

Suppose you want to make the slide containing the list of domestic animals into a
clipart and text slide. To do this, you need not insert a new slide with the preferred layout
and type the whole text again. Instead, you
can change the layout of the existing slide.

To change the slide layout:

1.   Select the slide to which you want layout
to be changed.

2.   Click the Home tab.

3.   Click the Layout option from the Slides
group.

The Module task pane appears (Refer
Figure 8).

Figure 7: Design templates
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4.   Use the scroll bar to view all layouts. Select the required layout, in this case, the Content
with Caption layout.

The selected layout is applied to the slide.

Now, you can add the clipart of your choice to this slide.

Adding Slide Transitions

Transitions control how slides will switch from one to the next during a slide show.
Transitions provide different effects for advancing to the next slide.

To add transition effects to your slides:

1.   Select the slide to which you want to apply transition.

2.   Click the Animation tab.

3.   From the Transition to This Slide group, select the type of transition that you want to
apply. (Refer Figure 10)

4.   Transition effect is applied to the slide. To apply the transition effect to all the slides,

5.  Click Apply To All button from Transition to This Slide group. (Refer Figure 10) Your
presentation is now ready to be displayed before the class.

Figure 10: Applying a Slide Transition

Note : Select the On mouse click check box to advance the slides only when you click the
mouse or press the required key on the keyboard.

Select the Automatically after check box for the slides to advance automatically.
You can specify a time in the spinner box below.

Now You Know

PowerPoint has different types of views that help you in constructing your
presentation. Some of them are:
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 Normal view – The screen is split into three sections showing the presentation outline
on the left, the slide in the main window, and notes at the bottom.

 Slide Sorter view – A small image of each slide is displayed in Slide Sorter view.
Slides can easily be ordered and sorted from this screen.

 Slide Show view – This view is used to see the full-screen slide show.

 Notes Page view – The Notes Page view is used to enter notes for slides within a
presentation.

You can change the appearance of your slide background by changing its colour,
shade, pattern or texture using the Background option on the Format menu.

Pictures can also be used in the background.

To change a slide layout, click the Layout option on the Home tab.

The transition style determines how one slide is removed from the screen and the
new one is displayed during the slide show.

 Demonstrate the enhancement in slide presentation.

1.   Start PowerPoint.

2. Create a presentation titled “Uses of Computers”. It must have at least five slides.

a)   Change the background to blue.

b)   Insert some pictures on computers.

c)   Add notes to each slide using the Notes Page View.

d)   Apply a design template.

e)   Add different slide transitions to each slide.

3. Save the presentation as “computers.ppt”. Use the Slide Show view to run the
presentation.

Teacher Activity

Student Activity
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Fill in the blanks

1. The __________ view shows small images of each slide where slides can be ordered
and sorted easily.

2. The __________  view is used to enter notes for slides within a presentation.

3. The __________  controls how slides will switch from one to the next during a slide
show.

4. The design templates are available in the __________

5.     __________ control how slides will switch from one to the next during a slide show.

 Normal View  Slide Sorter View

 Note Page View  Slie Show View

 Design Template  Animation

 Layout

*****

Test Your Knowledge

Key Words
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Figure 1: Changing the font type
using the formatting toolbar

Learning Objectives

In this chapter you will be able to ;

     Change the font type, size, colour and style using the formatting toolbar

   Use the Font dialog box

   Change the case of text

   Change the line spacing

Formatting Text

Word allows you to change the appearance of text so that it looks better. This can be
done by changing the font used in the Word document.

Font refers to the manner or style in which text is displayed in your document. You
can change the font type, font size, font colour and font style. This change in the style or
appearance of text is called formatting. For this, you need to use the formatting toolbar.

Changing the Font Type

The text is currently in the font Times New Roman. You want to change it to Comic
Sans MS.

To change the font:

1.   Select the text.

2.  Select a font from the Font drop-down list on the Font
group from the Home tab. (refer Figure 1).

The font of your text will change as shown below.

The Solar System is like a family made of objects in the
sky. The sun forms the center of the solar system. It is
surrounded by the other family members namely planets,
moons, asteroids and comets.

Chapter - 9 Formatting in MS Word
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The Solar System is like a family made of objects in the sky. The sun
forms the center of the solar system. It is surrounded by the other family
members namely planets, moons, asteroids and comets.

Text after changing the font to Comic Sans MS

Changing the Font Size

To change the font size of the heading to 20:

1.   Select the heading.

2.   Select 20 in the from the Font Size drop-down list on
the Font group from the Home tab. (refer Figure 2).

The font size of the heading has changed as shown
below.

The Solar System

The Solar System is like a family made of objects in the sky.

To format text using the Font dialog box:

1.   Select the text to be formatted.

2.   Click the Home tab.

3.   Click the Font dialog box launcher in the Font group.( An arrow next to the Font
group)

The Font dialog box appears as shown in Figure 4.

4.   Select the required options for font type, font size, font colour and font style.

5.   Click the OK button.

Figure 2: Changing the Font size

 
 

 

Font
dialogue box

launcher

Figure 3 : Font dialogue box launcher
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Changing the Font Style

You want to underline the main heading. You also decide to make the sub-headings a
bit thicker than the rest of the text and slant them. Word provides you with many styles like
Bold, Italics and Underline.

     The Bold option makes your text thicker.

     The Italics option makes your text slant to the right side.

     The Underline option puts a line below your text.

1. Select the heading and press the  button on the font group from the Home tab, to
underline the main heading.

2. Select each sub-heading and press the  button on the font group from the Home
tab, to make them thicker.

3. Use the  button on the font group from the Home tab, to italicise the sub-headings.

Note that the font styles of the text have changed (refer Figure 5).

Font Type

Font Colour

 

Font Style

Font Size

Figure 4 : The Font dialog box
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Bold and
Underlined
text

Bold and
Italicised text

Figure 5 : Text after applying changes to the font

Changing the Case of Text

If you want to change a sentence from lower case to upper case, you need not type
the whole sentence once again. You can use the Change Case option of Word.

For example, you want to change the sub-headings in your text to upper case. All you
need to do is:

1.   Select the heading.

2.   Click the Home Tab.

3.    Click the arrow next to the Change Case

(Change Case list) from the Font group.
(Refer Figure 6)

The Change Case dialog box is displayed as
shown in Figure 6.

4.   Select the UPPER CASE option.

5.   Click the OK button.

The selected text has now changed to upper case
(refer Figure 7).

The various options in the Change Case dialog
box are:

 

 

Figure 6 :
The Change Case dialog box

Figure 7 : Text with Upper Case
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Paragraph dialog box
launcher

Figure 8 : Paragraph dialog box launcher

Change the line
spacing here

Figure 9 : The Paragraph dialog
box

     Sentence case – Capitalizes the first letter of the selected sentence

     Lowercase – Changes the selected text to lowercase

     Uppercase – Changes the selected text to uppercase

     Title case – Changes the first letter of every word in the selected sentence to uppercase

     Toggle case – Changes all uppercase letters in the selected sentence to lowercase, and
all lowercase letters to uppercase

Changing the Line Spacing

Line spacing refers to the amount of space from the bottom of one line of text to the
bottom of the next line. Word bases the line spacing on the font size of the text. The line
spacing you select will affect all lines of text in the selected paragraph.

Word uses single line spacing by default. You want to change it to a line spacing of
1.5 lines. To change spacing between lines:

1.   Click the Home Tab.

2.   Click the Paragraph dialog box
launcher. (Refer Figure 8) The
Paragraph dialog box appears as
shown in Figure 9.

3. Select the Indents and Spacing tab.

4. In the Spacing section, change the value
in the Line Spacing drop-down list to 1.5
lines.

5.   Click the OK button.

The line spacing between the lines in your
document has changed (refer Figure 10).



ICT Teacher Hand Book 49

Summary

 Changing the appearance of text is called formatting.

 You can change the font type, its size, style and colour using the formatting toolbar.

 The Font dialog box can also be used to change the font properties.

 The Change Case option helps in changing the case from one to another.

 The Paragraph option on the Home Tab is used to maintain uniform spacing between
lines of text.

 Word 2007 offers several new features that make it easier to work with documents.

1.   Create a new Word document and type the following text.

The Air around us

The atmosphere is a mixture of many gases. The constituents of air are nitrogen,
oxygen, carbon-di-oxide, argon and others.

Nitrogen

Nitrogen forms the major constituent of air with 78% by volume. It is not a reactive
gas under normal conditions. Nitrogen compounds are essential for plant growth. Plants
make proteins from nitrates. Proteins are the building materials of all living things.

 

Text with line
spacing of 1.5

lines

Figure 10 : Changed line spacing in the document

Student Activity
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Oxygen

Oxygen is the next largest constituent of air with 21% by volume. Oxygen helps
combustion. Burning of candle, kerosene, petrol, etc are examples of combustion.
Respiration and rusting are also examples of combustion.

Carbon-di-oxide

The amount of carbon-di-oxide is very little (about 0.03%). But this amount increases
due to pollution. Carbon-di-oxide is used in fire extinguisher and aerated drinks. Dry ice is
used for cooling ice cream, packing fish and to deep-freeze some foods.

2.   Make the following changes to your document.

a)   Change the font type of the entire text to Courier New.

b)   Change the font size of the main heading to 18 points and underline it

. c)   Change the font size of the sub-headings to 14 points.

d)   Change the font colour to blue.

e)   Italicise all sub-headings.

f)    Change all the headings to bold.

g)   Change the line spacing of the entire text to 1.5 lines.

h)   Change the case of the sub-headings to title case.

i)    Change the main heading to upper case.

3.   Save the document.

Fill in the blanks

1.   The ____________ group helps you to change font style and font size.

2.   You can use the ____________ option on the Font group to change the character case.
font style makes your text look bolder.

3.   The ____________ option is used to give multiple line spacing.

4.   The ____________ option changes the selected text to lowercase.

*****

Test Your Knowledge
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Learning objectives

In this chapter you will be able to ;

        Find and replace text

        Check your document for spelling and grammatical mistakes

Find and Replace

The Find and Replace option is very useful in searching for specific text in your
Word document. It also helps you to replace the searched text with some other text. Using
this feature, you can either replace all or only few occurrences of a particular text. Such an
option is very useful when you are working with large documents where you can avoid
scrolling through the entire document to locate or replace the text you want.

To find and replace text:

1.   Click the Home Tab.

2.   Click the Replace button from the Editing group(refer Figure 1).

The Find and Replace dialog box with the Replace page appears as shown in Figure 2.

Figure 1: The Replace button from the Editing group

Chapter - 10 Proofing Document in Word

Figure 2: The Find and Replace dialog box
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Spelling
mistake

Grammatical
mistake

Figure 3: Document to be spell checked

3.   Enter the text you want to search in the Find What box.

4.   Type the text with which you want to replace the search text in the Replace with box.

5.   Click the Find Next button.

Word highlights the first occurrence of the search text.

6.   Click the Replace button to replace it. The next occurrence of the word is highlighted.

7.   Repeat step 6 till you get a message box informing you that there is no more search text
available in the document.

Tip :  If you do not want to change a particular occurrence of the word, click the Find
Next button.

If you want to replace the text wherever it appears in the same document all at one
once, click the Replace All button.

Spelling and Grammar

As you read earlier, Word can identify spelling and grammatical errors in your
document. It also provides suggestions to correct them. Word has a dictionary of words. If
the word you type is not present in the dictionary, it is underlined with a red wavy line. If
Word finds a sentence with a grammatical problem, it is underlined with a green wavy line
(refe Figure 3).
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To check for mistakes in spelling or
grammar:

1. Click the Review Tab.

2. Click the Spelling and Grammar
option.

The Spelling and Grammar dialog
box appears (refer Figure 4).
Word underlines the word “cenre”
in red. This is a spelling mistake.
Word also suggests some words
which it feels are correct.

3. The correct spelling for it is “centre”. Select it from the Suggestions list box below as
shown in Figure 4.

4. Click the Change button.

Tip :  To change all occurrences of a word to the suggestion, click the Change All
button.

5. Word then underlines the words “satellites that revolves” in green. This is a grammatical
mistake. The correct words for it are “satellites that revolve”. Select it from the
Suggestions list box.

6.   Click the Change button.

Word then continues with the spelling and grammar check for the rest of the document.
Accept the changes suggested by Word if you feel they are correct. Sometimes, you may
feel that a spelling or grammatical mistake pointed out by Word is not a valid one. In such a
case you can ignore the error by clicking the Ignore Once button.

     To prevent Word from pointing the
same word another time as a spelling
mistake, click the Ignore All button.

     To prevent Word from pointing the
same text another time as a grammatical
mistake, click the Ignore Rule button.

Figure 4: The Spelling and Grammar dialog box
showing a spelling mistake

Figure 5: The Microsoft Word message box
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When the check is complete, Word displays a message box as shown in Figure 5

7.   Click the OK  button.

Your document is now error-free.

Summary

     You can use the Find and Replace option to search for any text and replace it with some
other text.

     You can check your document for spelling and grammatical errors using the Spelling
and Grammar option on the Review tab.

1.    Create a new document and type the following text.

Food Production in Plants

All living organisms perform the basic functions of growth and reproduction. Food
is the fuel that gives energy to the living organisms. Where does this food come from?

Man gets his food from animals and plants. The animals get their food from plants.
Plants make their own food.

Plants have green leaves, which contain chlorophyll. This chlorophyll helps the plants
make its food. The process by which plants make their food is called photosynthesis.

In photosynthesis, carbon-di-oxide and water react to produce carbohydrates and
oxygen. The oxygen is released into the atmosphere, which we breathe.

The chlorophyll present in the leaves traps the light energy from the sun and converts
it into chemical energy to produce carbohydrates. This is later converted into starch and
stored in the plants. This food produced by plants forms the food for the other organisms
like animals and man.

2.   Find the text “make” and replace it with “prepare”.

3.   Save the document as “The Food We Eat”.

4.   Create a new document and type the following: Acid Rain

Acid rain is a common term for pollution caused when sulfur and nitrogen-di-oxide
combine with moisture in the air to produce a rain of sulfuric and nitricacids. Such pollution

Student Activity
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may also be suspended in a fog or the pollutants may be deposited in dry form. High levels
of acid rain have also been detected in many areas around the world. Acid rain can caused
severe environmental damage. It has destroyed plant and animal life in lakes, damaged forests
and crops, endangered life in coastal waters, eroded structures and contaminated drinking
water.

5.   Perform the Spelling and Grammar check on your document.

Accept the changes suggested by Word if you feel they are correct. Otherwise ignore
them.

Fill in the blanks

1. You can use the ________ with some other text.

2. The Replace option is found on the ______________ feature to search for a text and
replace it tab.

3. The text to be searched for must be entered in the ___________ text box.

4. To accept the suggestion given by Word in the Spelling and Grammar dialog box, click
the _________ button.

5. To ignore the suggestion given by Word in the Spelling and Grammar dialog box, click
the ___________ button.

*****

Test Your Knowledge



SCERT, T.S, Hyderabad56

Formatting Worksheets

Learning Objectives

In this chapter you will be able to understand about ;

    Format text and numbers

   Perform Auto Formatting and Conditional Formatting

Formatting Text

Your teacher wants you to improve the appearance of the marks statement file. You
can do this by using the various formatting features available in Excel. Formatting determines
how the information looks on the screen and how it appears when printed.

Formatting improves the appearance of the worksheet. You can format the data to
highlight important facts and make the worksheet easier to read.

Changing Alignment

As you know, label entries are left aligned by default, that is, they appear on the left
side of the cell. However, you can right-align or centre the label entries, if you want to.

Suppose you want to center align the column headings in Marks.xls file.

1.   Select all the column headings, starting from “Student” to “Average”.

2.   Click the Center  button on the Alignment Group in the Home tab.

All the headings are center-aligned as shown in Figure 1.

Figure 1: Aligning column headings

Chapter - 11 Formatting Data in Excel
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Your teacher suggests that you give a main heading to the worksheet and centre the
heading. So, you type the heading “Mark List” in cell A2 of the worksheet. You now have to
centre the main heading. This heading has to be centred across a range of cells and not
within a cell as in the earlier case.

To do this:

1.   Select the cells across which you want to centre the heading, starting from the cell A2.

2.   Click the Merge and Center  button from the Alignment group on the Home Tab.

The heading is aligned to the center of the entire marks statement (refer Figure 2).

Changing the Font Type, Size and Colour of Text

You can also change the font type, colour and size of the text in your worksheet.
Suppose you want to change the font type to Comic Sans MS.

To do so:

1.   Select the entire text.

2.   Select Comic Sans MS in the Font drop-down list from the Home Tab (refer Figure 3).
The font is changed.

Suppose you want to change the font size of the heading to 14 and the font colour to
brown. To change the font size and colour:

1.   Select the heading.

2.   Select 14 in the Size drop-down list from the Home Tab (refer Figure 3).

3.    Select the brown colour in the Font Color drop-down list from the Home Tab (refer
Figure 3).

Figure 2: The Merged and Centred Text
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Your text appears as shown in Figure 4.

Changing the Font Style

An ordinary looking text can be well highlighted, by making it Bold, italicised or
underlined. You can make these changes by using the options available in the Font group on
the Home Tab.

    The Bold  option makes the selected text thicker..

   The Italics  option makes the selected text slant to the right side.

   The Underline  option puts a line below the selected text.

Formatting Numbers

The appearance of numbers in the cells can be changed using a variety of options in
the Number tab of the Format Cells dialog box.

Suppose you want the average marks of each student to contain two decimal places
only. To change the number format:

1.   Select the average marks of all the students.

2.   Click the Home tab.

3.   Click the Number group dialog box launcher.

Figure 3: The formatting toolbar

Figure 4: Text after changing the font type, font size and font colour
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The Format Cells dialog box appears. (Refer Figure 6)

4.   Click the Number tab (refer Figure 6).

5.   Select the Number option in the Category list
box.

Number group dialog box launcher

6.   Select 2 in the Decimal Places spinner box.

7.   Click the OK button.

Formatting Rows and Columns

Changing Row Height and Column Width

Excel allows you to change the row height
and column width in a worksheet. To resize rows:

1. Move the mouse pointer over the row border, which you want to resize.

The mouse pointer changes to a double-headed arrow .

2.   Click and drag the boundary until the row height changes to the height you want. To
resize columns:

1.   Move the mouse pointer over the column border, which you want to resize.

The mouse pointer changes to a double-headed arrow .

2.   Click and drag the boundary until the column width changes to the width you want.

    Tip :  If you want Excel to automatically size your rows or columns:
1. Click the Home Tab.
2. Click Format list box from the Cells group. A submenu appears.
3. Click the AutoFit option.

Figure 5: Number group dialog box launcher

Figure 6: The Number page of the
Format Cells dialog box
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Figure 7: The Border page of the
Format Cells dialog box

Adding Borders and Patterns to Cells

To put borders around the column
headings:

1.   Select the column headings.

2.   Click the Home Tab.

3.   Click the Font/Number/Alignment dialog
box launcher.

A Format Cells dialog box is displayed.

4.   Select the Border tab (refer Figure 7).

5.   Select the border style and colour of your
choice.

6.   Click the OK button.

Adding Background Colour

To apply background colour to the column headings:

1.  Select the column headings.

2.   Click the Home Tab.

3.   Click the Font/Alignment/Number dialog box
launcher.

The Format Cells dialog box appears.

4.   Select the Fill tab.

5.   Select the colour and pattern of your choice.

6.   Click the OK button.

Auto Formatting

This feature enables you to format a range of cells, into a table format. You can
choose from a list of standard formats.

1.   Select the range of cells to be formatted as a table format.

2.   Click the Home Tab.

The background for the columns heading
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3.   Click the Format as Table option from the Styles group. (Refer Figure 9) The
AutoFormat dialog box appears as shown in Figure 10.

4.   Select the format of your choice.

5.   Click the OK button.

Conditional Formatting

Excel allows you to format cells based on specific conditions. However, you can
give a maximum of only three conditions.

For example, in the marks statement worksheet, you can give a red colour to marks
below 50, a green colour to marks between 50 and 80 and a brown colour to marks above
80.

Figure 9: The Styles group

Figure 10: Format as Table dialog box
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Figure 12 : Conditional Formatting option

Figure 13 : Conditional Formatting option

To set the above conditions:

1.   Select the range of cells.

2.   Click the Home Tab.

3.   Click the Conditional Formatting
button from the Styles Group. (Refer Figure
12)

4.   Select Highlight Cells Rules -> Greater
than option.

Greater Than dialog box appears. (Refer
Figure 13)

5.   Enter the condition.

6.   Select the colour with which you want
to highlight the cell from the options
available in the with list box.

The colour for the selected condition is applied to the cell. (Refer Figure 14)

Summary

 Formatting a worksheet improves the
appearance of the worksheet.

 The formatting features of Excel allows
you to change the font, font style, font
colour, font size and alignment, add
borders and patterns to cells and change
the way the numbers are displayed.

 You can change the column width and row
height in a worksheet.

 The Format As Table button on the Styles
Group enables you to format a range of
cells, into a table format.

 The Conditional Formatting feature enables you to format cells based on certain
conditions.

Figure 14 : Cells highlighted with colour
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1. Open the file Marks.xls.

2. Change the font size of the main title Mark List to 20.

3. Merge and center the title and make it appear in bold.

4. Centre all the column headings and make it appear Bold.

5. Centre the marks and percentage columns.

6. Format the column which contains the average to 0 decimal places.

7. Apply a dark blue background to the column headings.

8. Change the font colour of the column headings to light blue.

9. Draw a border around the marks statement.

10. Save and close the file.

True or False

1. Formatting options are present on the Home Tab.

2. Numeric data cannot be formatted.

3. To centre text across multiple cells, use the Merge and Center button.

4. The AutoFit option adjusts the width of the columns automatically.

5. The AutoFormat option is available on the Insert tab.

*****

Student Activity

Key Words
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2. Choose the All
Programs option

1. Click the
Start button

Figure 1: Starting Access

4. Select the
Microsoft Office

Access 2007

3. Click the
Microsoft

Office option

Learning Objectives

In this chapter you will be able to understand about ;

    Start Access

    Identify the parts of the Access window

    Create a database by using the database wizard

    Create a database by using the Blank database option

    Exit a database

    Exit Access

Starting Access

To start Access:

1.   Click the Start button.

2.   Choose the All Programs option. A submenu appears.

3.   Click the Microsoft Office option.

4.   Click the Microsoft Office Access 2007 option. (Refer Figure 1)

Chapter - 12 More About MS Access
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The Access window appears (refer Figure 2).

New Interface elements of MS Access 2007 Window

The major new interface elements in MS Office Access 2007 are:

 Getting Started with Microsoft Office Access: It is the page that is displayed when
a user starts MS Access 2007 from the Windows Start menu or from a desktop shortcut.
Microsoft Office Button: This button is located in the upper-left corner of the MS
Access 2007 window.

 Ribbon: It is the area at the top of the program window from where a user can choose
commands. It is designed for easy browsing. It consists of tabs and the controls on
each tab are further organized into several groups. The Ribbon can host richer content
than menus and toolbars, including buttons, galleries and dialog box content.

 Command tab: It is a tab that displays commands that are generally used together. It
is found on the top of the ribbon.

 Contextual command tab: It is a command tab that appears depending on the context.

 Gallery: It displays a preview of a style or option that enables a user to see the results
before committing to a choice.

 Quick Access Toolbar: It is a single standard toolbar that appears in the ribbon and
offers single-click access to most needed commands, such as Save and Undo.

 Dialog Box Launchers: These are small icons that appear in some groups. When the
Dialog Box Launcher is clicked, a related dialog box or task pane opens. This provides
more options related to that group.

Figure 2: Access window
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 Navigation Pane: It is the area on the left side of the window that displays your database
objects. This replaces the Database window from earlier versions of Access.

 Tabbed documents: It displays tables, queries, forms, reports, pages and macros as
tabbed documents.

 Status bar: It is the bar at the bottom of the program window. It displays status information
and includes buttons that permit a user to alter the view.

 Mini toolbar: It is a toolbar-like element that transparently appears above the text
that has been selected. It helps to format the text such as changing the font or using
bold or italic.

Creating a Database

A database can either be created by using the Database Wizard option or by using
the Blank Database option.

 Database Wizard – Is used to create tables, forms, queries and reports by following a
series of steps provided by the wizard. The wizard provides a step-by-step process to
achieve the desired result.

 Blank Database Option – Is used to create a blank database. All other database objects
should be created manually.

Tip : Wizard is a utility that provides a guided sequence to perform complex tasks
easily and quickly. Wizards ask you questions about the contents, style and format of
the object that you want to create and then create the object automatically. You need
to answer the questions by selecting options like Yes/No.

Creating a Database Using the Database Wizard (Templates)

Access provides a number of templates that can be used to create a database of a
specific type. For example, you can create a database that contains the list of your friends
and their contact information. Access also provides easy methods to create the database of
your choice. Database wizard in Access provides you with a sequence of guided steps to
create databases.
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To invoke the database wizard:

1. The Local Templates dialog box appears (refer Figure 3).

5. Select the Local
Templates from
the Template
Categories.
(Refer Figure 3)

6.   Click the Contact
button.

7.   Enter the name of
the database in the File
name text box.

In Figure 4, Contacts is the database name entered in the File
name text box.

8.   Click the Create button.

The Contacts table window is displayed. (Refer Figure 5) Quick

The Contacts database gets created with all the required forms and reports
corresponding to the database.

Figure 3: The Template dialog box:
Figure 4: Local

Template Database
Wizard

Tabs

Group

Right
pane

 

Access
Toolbar

Navigation
Pane

Figure 5: Student List table window
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Components of Database Window

The various components of the database window are:

Navigation Pane – It displays all the objects of the database. Tables, Forms, Query, Macros,
Reports and Modules.

Right Pane – It outlines all the corresponding elements associated with selected database
objects in the object bar.

Creating a Database by using the Blank Database Option

The Blank Database option helps you to create a blank
database in which tables, queries, forms and reports can be added
according to your requirement.

The database templates provide a limited number of
options. If you wish to create a database for which you do not find
a suitable template, you can use the Blank Database option to create
a blank template. Thereafter, you can create tables and the other
objects on your own.

To create a blank database:

1.   On Getting Started with Microsoft Office Access page, under
New Blank Database, click Blank Database.

2.   In the Blank Database pane, type a file name in the File Name
box.

3.   Click the Browse folder icon (next to the File Name box) for a location to place the
database.

4.   Browse to the new location and click OK.

5.  Click Create.

Access creates the database with an empty table named Table1 and opens Table1 in
the Datasheet View (Refer Figure 6). The cursor is placed in the first empty cell in the Add
New Field column.

Now, data can be added by typing it or by pasting it from another source.
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Entering information in Datasheet view is very similar to working in Microsoft Office
Excel

2007 worksheet. A new field is defined when a new column is added to the table.
Access automatically sets each field’s data type, based on the data that is entered.

In case no more information is to
be entered in Table1, click Close. If
changes are made to the table, MS Access
prompts to save changes to the table. So,
click Yes to save the changes, click No
to reject them or click Cancel to leave
the table open.

Closing a Database

To close a database:

1.   Click the Office Button.

2.   Click the Close Database option. The database gets closed.

Closing Access

To exit the Access window:

1.   Click the Office Button.

2.   Click the Exit Access option. The Access window gets closed.

Summary

 To invoke Access, click the Microsoft Access option on the All Programs-> Microsoft
Office.

 The Blank Database option is used to create database in which the tables, queries, forms
and reports can be added according to your requirement.

 To open an existing database, click the Open option from the Office Button.

 To exit the Access, click the Exit Access option from the Office Button.

Figure 6: Datasheet view
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1. Demonstrate creating data base in Access.

1.   Create a database called Friends Details by using the Blank Database option.

2.   Create a Cricket database by using the Blank Database option.

Fill in the Blanks

1. The                               option is used to create a database through a sequence of guided
steps.

2. The                           shows the current status of the ongoing task.

3. The Close Database option on the                         button is used to close a database.

4. The                                   is used to create a step by step method to create a database.

 Interface tab   Navigation pane   Database wizard

*****

Teacher Activity

Student Activity

Test Your Knowledge

Key Words
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Learning Objectives

In this chapter you will be able to ;

   Know what is WWW?

  Explain the advantages of using WWW

   Define URL

   Define the term Web browser

   Use the Internet Explorer to browse

   Recall the terms used in Internet

World Wide Web

WWW stands for the World Wide Web. It is a series of interconnected servers that
contains information in the form of text, pictures, sounds and animation.

You would have seen a library. It consists of millions and millions of books with
pages of text, pictures, sounds and animation. WWW is very similar to a library. Just like a
library, WWW has information on different topics. These information pages are stored on
different computers that are connected to the Internet and have links between them. When
you click on a certain word, which is a link in the page, it will take you to another page.
Such text, which act as a link between Web pages, are called hypertext. These links are
called hyperlinks and the pages are known as Web pages. A collection of related Web
pages is known as a Web site, which is similar to a book containing related information.
The first Web page that gets displayed when the user opens any Web site is called the Home
page.

Advantages of Using WWW

The advantages of WWW are:

 A user can click any hyperlink present on the Web page and jump to a related Web
page on the same or a different Web site.

 A Web page can contain text, pictures, audio, and video clips which makes it interesting
to the user.

Chapter - 13 Internet
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 A user can interact with a Web page by filling a form, by running a program or select
options from a Web page.

URL

You know that each house has an address. The address has a door number, street
name, city name and pin code. The address is used to locate a house easily. Similarly each
web site has an address. This address is called the URL (Uniform Resource Locator) to a
Web site.

Examples for Web site address are:

   www.yahoo.com

   www.hotmail.com

   www.google.com

Web Browsers

We are already aware of the process of connecting to the Internet. But, more than
connecting to the Internet, you should be able to use the services provided by the Internet.
For example, you may use WordPad to type a letter and Paint to draw a picture. Likewise,
Web Browser is a software program using which you can open any Web site to browse and
avail the services offered by the Web site. Web browsers are capable of displaying Web
pages containing text, pictures, sound and video files.

The commonly used Web browsers are:

   Internet Explorer

  Netscape Navigator

   Hot Java

  Opera

Using the Internet Explorer

The Microsoft Internet Explorer is a Web browser developed by Microsoft. The
Internet Explorer comes free when you buy Windows 98 or Windows 2000 or Windows XP
operating system.
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To launch Internet Explorer:

Double-click the Internet Explorer icon ( ) present on the desktop. Alternatively,,

1.  Click the Start button.

2.  Click the Internet Explorer option from the menu.

The Internet Explorer window opens up as shown in Figure 1

The Internet Explorer window has title bar, menu bar, toolbar, address bar and status
bar. To visit a web site, you have to type the Web site address in the address bar and press the
Enter key. The home page of the corresponding Web site will be displayed (refer Figure 2).

Figure 2: Yahoo Home Page

Click the Forward button on the toolbar to move to the next page and the Back
button to go to the previous Web page visited.

 Title Bar

Menu Bar

Address
Bar

Figure 1: Microsoft Internet Explorer Window
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Terms Used in the Internet

Let us recall the Internet terms, which you have already learnt.

 Web browser is a software that allows the user to display and interact with a Web site.

 Web page is a page which may contain text, pictures, audio, and video clips.

 Web site is a collection of related Web pages.

 Home page is the first Web page displayed when the user opens any Web site.

 Hypertext Transfer Protocol (HTTP) is a protocol used on the WWW to transfer Web
pages. A protocol is a set of rules that the computers follow to communicate with each
other.

 HTML (Hypertext Markup language) is a language used to create Web pages.

 Uniform Resource Locator (URL) is a Web addressing system that is used to identify
each Web site uniquely on a network.

Example of an URL: http://www.aub.edu/services/faq.html

Summary

 WWW stands for the World Wide Web. It consists of millions and millions of Web
pages.

 Collection of related Web pages is known as Web site that is stored on different
computers that are connected to the Internet.

 Hyperlinks are used to link the related Web page.

 Web page is a page which may contain text, pictures, audio, and video clips.

 Home page is the first Web page displayed when the user opens any Web site.

 A protocol is a set of rules that the computers follow to communicate with each other.

 Hypertext Transfer Protocol (HTTP) is a protocol used on the WWW to transfer Web
pages.

 HTML (Hypertext Markup language) is a language used to create Web pages.

 Uniform Resource Locator (URL) is a Web addressing system that is used to identify
each Web site uniquely on a network.
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 Internet Explorer is a Web browser developed by Microsoft.

 A Web browser is a program that enables you to view the Web site available on the
WWW.

 You can open the Internet Explorer using the Internet Explorer icon on the desktop.

 The Internet Explorer window has the Address bar where you type the Web site address.

 Demonstrate creating a HML Page.

I  Create a Web page using template.

 Browse various websites and observe.

II Lab Work

1. Visit http:/ http://www.nineplanets.org/ to collect information about the solar system.

2. Visit http://www.nationalgeographic.com/kids/creature_feature/archive/ to view
photographs of animals and collect information about them.

3. Visit http://www.petsmart.com to gather information on your favourite pet..

4. Visit http://www.mapsofindia.com/maps/andhrapradesh/andhra-pradesh-district.htm to
view the map of Andhra Pradesh.

5. Visit www.indiatravelinfo.com/wildlife.htm to learn about wildlife sanctuaries in India.

6. Browse the site http://www.historyofindia.com to get information about Indian history.

7. Visit http://www.jiskha.com/social_studies/world_issues/ozone_depletion.html and
learn about ozone depletion.

Fill in the blanks

1.                         is software that allows the user to display and interact with a Web site.

2.                            is a collection of related Web pages.

3. HTTP stands for                                .

4. HTML stands for                                .

Teacher Activity

Student Activity

Test Your Knowledge
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5. The address of a Web site is also called                                .

6. WWW stands for                                            .

7.                   are the pages on the Internet that contain text, pictures, sounds and animation.

8.                       is a set of rules that the computers follow to exchange information.

9. You have to type the Web site address in                      bar.

10. The first page that appears after opening a Web site is known as                         .

 HTML

   Web Page

   Website

*****

Key Words
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Projects
1. Collect the data of class 10 pass percentage of your school for five years and create

bar chart, pie chart, column chart and space chart.
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